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ВСТУП 

3D-моделювання – це технологія, за допомогою якої можуть бути 

створені тривимірні моделі будь-якого даного об'єкта. Технологія є дуже 

важливою з кількох причин, які чітко описані нижче. 

Суттєве місце у освітній діяльності, навчально-виховній роботі 

закладу вищої освіти займає музей історії його закладу. Музей розвиває 

у студентів зацікавленість до майбутнього професійного фаху, повагу до 

історії свого університету, сприяє формуванню наукового світогляду, 

професійних навиків та високих морально-патріотичних якостей. 

Але умови для масового впровадження практики створення 

віртуальних музеїв в наш час, зокрема у закладах вищої освіти повною 

мірою не створені. Тому подальше дослідження спрямоване на пошук 

можливостей створення умов для його реалізації, в першу чергу, на 

прикладі створення віртуального музейного простору університету. 

● Точність, яку містять тривимірні моделі, не має аналогів і жоден 

інший звичайний підхід до моделювання або візуалізації не може бути 

настільки точним, як 3D-моделювання. 

Мета роботи – дослідження існуючих підходів і концепцій та 

створення 3D образів музейних експонатів для віртуального музею 

КНТЕУ.  

Об’єкт дослідження – віртуалізація музейного простору історії 

КНТЕУ.  

Предмет дослідження: технічні та програмні засоби відтворення 

3D-образів музейних експонатів КНТЕУ 

Завдання дослідження: аналіз вітчизняних і зарубіжних публікацій 

та інформаційних джерел  по темі науково-дослідної роботи. 
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Розділ 1 

Сучасні технології 3D-моделювання 

РОЗДІЛ 1 

СУЧАСНІ ТЕХНОЛОГІЇ 3D-МОДЕЛЮВАННЯ  

1.1 3D МOДEЛI В СУЧАСНІЙ ІТ- IНДУCТPIЇ 

З моменту розробки 3D програм ми можемо спостерігати зростання 

просторового розвитку 3D-архітектури та мистецтва. З моменту свого 

першого виникнення в 1976 році ми почали  бачити, як вона стала 

невід'ємною складовою нашого повсякденного життя. 

Але все починається з 3D-моделі. 3D-моделювання 

використовувалося протягом десятиліть для створення програмного 

забезпечення, мистецтва та технологічних удосконалень у відповідних 

областях. Завдяки цьому промисловість 3D-моделювання повинна 

досягти 16,6 мільярдів доларів США протягом 2020 року. 

3D-моделювання - це техніка, яка використовується для створення 

3D-зображення будь-якої поверхні або об'єкта. Художник використовує 

спеціальне програмне забезпечення, щоб керувати точками у 

віртуальному просторі (називається вершинами). Це допомагає їм 

сформувати сітку, яка є групою вершин, які створюють об'єкт. 

Ці 3D-об'єкти можуть бути створені автоматично або шляхом 

ручного деформування сітки, або шляхом маніпулювання вершинами. 

3D-моделі використовуються для безлічі середовищ, включаючи фільми, 

ілюстрації, відеоігри, архітектуру, комерційну рекламу та інженерію. 

Процес 3D-моделювання створює цифровий об'єкт, здатний стати 

повністю анімованим, що робить його важливим процесом для 

спеціальних ефектів і анімації персонажів. Сітка - це сукупність 

декількох точок у просторі. Кожна з цих точок додає до вашої 

конструкції остаточну 3d-модель. 
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1.2 АНАЛIЗ ICНУЮЧИХ ПPOГPАМНИХ ЗАCOБIВ 

Adobe Photoshop – багатoфункцioнальний гpафiчний peдактop, 

poзpoблeний фipмoю Adobe Systems. В ocнoвнoму пpацює з pаcтpoвими 

зoбpажeннями, пpoтe має дeякi вeктopнi iнcтpумeнти. Пpoдукт є лiдepoм 

pинку в oблаcтi кoмepцiйних заcoбiв peдагування pаcтpoвих зoбpажeнь i 

найбiльш вiдoмим пpoдуктoм фipми Adobe. 

Blender – вiдкpитe пpoгpамнe забeзпeчeння для cтвopeння 

тpивимipнoї кoмп'ютepнoї гpафiки, щo включає в ceбe заcoби 

мoдeлювання, анiмацiї, peндepинга, пocтoбpoбки i мoнтажу вiдeo зi 

звукoм, а такoж для cтвopeння iнтepактивних iгop. В даний чаc 

кopиcтуєтьcя найбiльшoю пoпуляpнicтю cepeд бeзкoштoвних 3D-

peдактopiв в зв'язку з йoгo швидким i cтабiльним poзвиткoм, якoму 

cпpияє пpoфeciйна кoманда poзpoбникiв. Хаpактepнoю ocoбливicтю 

пакeту Blender є йoгo нeвeликий poзмip в пopiвняннi з iншими 

пoпуляpними пакeтами для 3D-мoдeлювання. 

Mixcraft – це програма багатоканального запису для Windows. Це 

програмне забезпечення для запису музики функціонує як робоча 

станція цифрового звуку, MIDI секвенсор, віртуальний хост приладу, 

нелінійний аранжувальник відео та програма запису музичних циклів. 

Основні можливості програми 

 MIDI: Ця функція дозволяє записувати MIDI-дані, які 

відтворюються на одній або декількох клавіатурах MIDI-контролера. 

 Multitrack Recording: Ця функція дозволяє користувачам 

створювати записи з декількох звукових / аудіовходів одночасно. 

Unreal Engine 4 – ігровий рушій, розроблений і підтримуваний 

компанією Epic Games. Написаний на мові C ++, рушій дозволяє 

створювати ігри для більшості операційних систем і платформ: Microsoft 
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Windows, Linux, Mac OS і Mac OS X, консолі Xbox, Xbox 360, PlayStation 

2, PlayStation Portable, PlayStation 3, Wii, Dreamcast і Nintendo GameCube. 

Код рушія може використовуватися в будь-яких комерційних 

проектах, але з розробників даних проектів здійснюється відрахування у 

розмірі 5% від доходу, отриманого від продажу гри користувачам. Збір 

відрахувань з доходів від продажу робить рушій Unreal Engine 4 цікавим 

рішенням не тільки для великих ігрових проектів, але і для невеликих 

стартапів і авторів безкоштовних ігор. 

Adobe Fuse CC - (раніше Fuse Character Creator) - це програмне 

забезпечення для комп'ютерної графіки 3D, розроблене компанією 

Mixamo, що дозволяє користувачам створювати 3D-персонажі. Її 

головна новизна - можливість імпортувати та інтегрувати вміст, 

створений користувачем, до створення персонажа. Fuse є частиною 

набору продуктів Mixamo, і призначений для розробників відеоігор, 

модераторів відеоігор та 3D-ентузіастів. 

Fuse - продукт на основі клієнта, що дозволяє користувачам 

вибирати та змінювати компоненти символів, такі як частини тіла, в 

режимі реального часу. Основною новинкою Fuse є можливість 

імпортувати та автоматично інтегрувати свій власний вміст у систему 

створення персонажа, використовуючи всі функції попередньо 

завантаженого контенту. 

 Fuse використовується в основному для розробників ігор і 

модераторів ігор. Fuse доступний на Mixamo, на Unity Asset Store і на 

ринку Steam, де з вересня 2014 року він має 40 000 користувачів. 

Персонажів Fuse можна імпортувати через певну серію кроків у ігри, 

створені за допомогою Source SDK. 



 
Изм. Лист № Документа_ Подпись_ Дата

_ 

Лист 

9 

 

КНТЕУ 6.050103 7-17.БР 

 

1.3 POЗPOБКА ЗАГАЛЬНOЇ КOНЦEПЦIЇ ПРОЕКТУ 

 В даній роботі реалізується рухома модель персонажу зі 

змогою взаємодії  

з навколишнім середовищем. Із навколишнього середовища буде 

створений музей КНТЕУ, відтворена його архітектурна форма та 

внутрішній інтер’єр та оздоблення. 

 

Pиc. 1.1 Пepcoнаж 

1.4 ВИCНOВКИ ДO ПЕРШОГО POЗДIЛУ 

 В першому розділі була: 

1. Вивчена потрібність 3D моделей в ІТ індустрії. 

2. Проаналізовані існуючі програмні засоби для реалізації 

розробки. 

3. Розроблена загальна концепція музею КНТЕУ. 
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Розділ 2 

Технічне завдання на розробку 

інтерактивного додатку 3D-музею КНТЕУ 

РОЗДІЛ 2 

ТEХНIЧНE ЗАВДАННЯ НА РОЗРОБКУ ІНТЕРАКТИВНОГО 

ДОДАТКУ 3D-МУЗЕЮ КНТЕУ 

2.1. ВИМОГИ ДО ТЕХНІЧНОГО ЗАВДАННЯ 

 Мета - підвищення ефективності освітнього процесу в 

сучасних умовах за рахунок використання нових інформаційних 

технологій (Web, Internet), що забезпечують багатофункціональність, 

багатоваріантність, гнучкість і оперативність;  

 Завдання дослідження: аналіз вітчизняних і зарубіжних 

публікацій та інформаційних джерел  по темі науково-дослідної роботи. 

1. Вимоги по розробці музею: 

 Музей повинен відповідати дійсності. 

 Музей повинен надавати достовірну інформацію. 

 Модель персонажа має бути повністю дієздатною для взаємодії 

з середовищем, мати можливість рухатися. 

 2. Розміри 

 Музей у своєму фінальному вигляді повинен відповідати 

приблизним розмірам справжньої кімнати. 

 3. Анімація 

 В готовому проекті має бути анімований персонаж, для того 

щоб пересуватись по музею без перешкод. Також повинна бути створена 

анімація відчинення та зачинення дверей. 

 4. Взаємодія 

 В готовому проекті мають бути декілька експонатів музею з 

якими персонаж зможе взаємодіяти, наприклад отримати детальну  
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інформацію про історичну подію або постать. 

2.2 ОПИС ЕТАПІВ РОЗРОБКИ 3D МОДЕЛЕЙ 

2.2.1 Modeling 

Моделювання - це процес візуального зображення об'єктів і 

поверхонь для подальших маніпуляцій. Якщо потрібно створити 

статичний 3D-актив, який не буде виконувати складний набір анімації, 

моделювання стане необхідним способом його створення. Весь процес 

моделювання може бути завершений багатьма способами, залежно від 

того, який з них є найбільш привабливим для 3D-художника. 

 Примітивне моделювання означає створення простих 3D-

об'єктів, таких як сфери, кубики, конуси, змінюючи їх атрибути. 

Використовуючи Modeling Toolkit, виконавець може розділяти, 

витягувати, об'єднувати або видаляти компоненти з об'єктів, щоб 

зробити примітивний об'єкт більш-менш складним. 

 Моделювання кривих - це метод створення 3D-активів, коли 

поверхні маніпулюють кривими, які контролюються зваженими 

контрольними точками. Змінюючи вагу для певної точки, художник 

може наблизити криві до певної точки. Ці криві включають сплайни, 

патчі та NURBS. 

 Конвертація - це метод створення полігонів за допомогою 

моделей поверхні NURBS. 

 Окремі полігони можуть бути зроблені шляхом розміщення 

окремих вершин для демонстрації окремих полігонів. Інструмент 

"Створити багатокутник" або "Quad Draw Tool" може або витягнути, або 

розбити вид полігональної сітки. 
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2.2.2 Retopology 

Враховуючи, скільки полігонів має висока деталізована модель (іноді 

до 10M), часто стає неможливим створювати належні анімації з 

кількістю точок впливу, з якими має займатися 3D-художник. 

Використовуючи функцію Quad Draw в Toolkit моделювання, у вас є 

доступ до маркування по всій моделі, що дозволяє створювати значно 

спрощену нову топологію на основі поверхні еталонної моделі. 

2.2.3 UV Mapping 

 

Рис. 2.1 UV poзгopтка 

Цей етап означає, що виконавець може зробити 2D-зображення і 

застосувати його до поверхні 3D-моделі для подальшого відображення 

текстур. 
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Розфарбовуючи полігони 3D-моделі кольором та іншими 

параметрами відображення, UV Mapping призначає пікселі зображення 

поверхневим відображенням багатокутника шляхом копіювання та 

вставки фрагмента зображення на об'єкт. 

2.2.4 Rigging 

 

Рис. 2.2 Всі рухомі частини персонажу 

Rigging - це процедура створення "скелета" і прив'язка його до 3D-

сітки. Як скелет в реальному житті, він складається з ряду швів, які 

можуть маніпулювати моделлю, щоб згинатися або нахилятися в 

певному напрямку. 

2.3 ВИСНОВКИ ДО ДРУГОГО РОЗДІЛУ 

 В другому розділі було: 

1. Визначено завдання на розробку інтерактивного додатку 3D-

музею КНТЕУ. 

2. Поставлені вимоги до технічного завдання. 

3. Описані етапи розробки 3D моделей. 
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РОЗДІЛ 3 

РЕАЛІЗАЦІЯ ІНТЕРАКТИВНОГО ДОДАТКУ 3D-МУЗЕЮ 

КНТЕУ 

3.1 ВИКОРИСТАНЕ ПЗ 

 Для реалізації алгоритму було обрано такий набір програмного 

забезпечення: 

Назва Плюси Мінуси 

Mixcraft 8 

 Зрозумілий інтерфейс; 

 Можливість запису 

одразу з декількох 

аудіовходів; 

 Можливість роботи з 

усіма аудіо форматами; 

 Висока надійність 

 Унікальні інструменти. 

 За час використання 

суттєвих недоліків не 

було виявлено. 

Unreal Engine 4 

 Безкоштовний; 

 Можливість візуального 

програмування; 

 Потужний редактор 

матеріалів та штучний 

інтелект; 

 Фото-реалістична 

візуалізація. 

 Високі системні 

вимоги. 

Таблиця 3.1. 

Кінець таблиці 3.1. 
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3.2 ЕТАПИ СТВОРЕННЯ ІНТЕРАКТИВНОГО ДОДАТКУ 3D-

МУЗЕЮ КНТЕУ 

 Створення кімнати; 

 Створення базових елементів інтер'єру; 

 Моделювання експонатів; 

 Взаємодія з тривимірними об'єктами. 

Перше, що необхідно зробити при створенні 3Д музею – це створити 

кімнату в якій в подальшому будуть розміщуватись експонати. Для цього 

необхідно провести розрахунки розмірів експонатів та самої кімнати. 

Для початку необхідно створити підлогу. Для цього необхідно відкрити 

вкладку «Geometry»,  в якій треба вибрати фігуру «Box». 

 

Рис. 3.1. Керування геометричними об'єктами 

Далі необхідно розширити простір. За допомогою вкладки «Geometry 

Editing» розширюємо куб по осям. 
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Рис. 3.2. Створення підлоги 

Наступний етап у створенні кімнати – це стіни. Для створення стіни 

необхідно відкрити вкладку «Geometry»,  в якій треба знову вибрати фігуру 

«Box». 

 

Рис. 3.3. Створення стіни 

Далі необхідно розтягнути куб по осям. 
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Рис. 3.4. Створення стіни 

Копіюємо та розміщуємо стіни так, щоб вийшла коробка. 

 

Рис. 3.5. Необроблена кімната 

Після виконання цих пунктів можна поступово переходити до базових 

елементів інтер'єру. 

Для підлоги було використано дерев'яну текстуру. 
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Рис. 3.6. Матеріал підлоги 

Так виглядає підлога  після покриття дерев'яним матеріалом. 

 

Рис. 3.7. Матеріал підлоги 

Далі стіни покриваємо таким самим способом, але іншим матеріалом. 
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Рис. 3.8. Матеріал стіни 

Після облаштування стін та стелі кімната має наступний вигляд. 

 

Рис. 3.9. Вигляд кімнати 

Для кращого освітлення необхідне потрапляння зовнішніх джерел 

світла.  

Для створення вікон необхідно в одній зі стін проробити отвори. Для 

цього відкриваємо вкладку «Geometry»,  де вибираємо фігуру «Box». Далі в 
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параметрах пензля (Brush Settings) вибираємо параметр «subtractive», після 

чого куб стає невидимим і його необхідно пересунути так, щоб він 

перетинався з іншим геометричним об'єктом. 

 

Рис. 3.10. Створення вікна 

Наступним кроком просто копіюємо вікна та розміщуємо іх як це 

потрібно. 

 

Рис. 3.11. Послідовне розміщення вікон 

Отвори готові, але залишати вікна без рами та скла не можна. Для рами 

використаємо 3D-модель металопластикового вікна. 
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Рис. 3.12. Модель вікна 

Рис. 3.13. Моделі вікон 

Після створення кімнати з базовим інтер'єром можна перейти до її 

заповнення елементами декору. В музеї КНТЕУ є декілька видів стендів і 

вітрин. Розглянемо п'ятикутну та прямокутну вітрини які займають своє 

місце біля вікна. 
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Рис. 3.14. П'ятикутна та прямокутна вітрини 

В арсеналі платформи Unreal Engine 4 немає складних геометричних 

фігур, таких як додекаедр, пентагондодекаедр або будь-який об'ємний 

п'ятикутник, тому довелося створити його використовуючи куб. 

Створимо паралелепіпед який буде складатися с куба та паралелепіпеда 

менших розмірів. 

 

Рис. 3.15. Прямокутний кубоїд 

В 2D редакторі за допомогою мишки перетворюємо прямокутник в 

правильний п'ятикутник – пентагон. 
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Рис. 3.16. Пентагон 

Отримавши п'ятикутник покриваємо його дерев'яним матеріалом. 

 

Рис. 3.17.  Дерев'яний пентагон 

Для того, щоб зробити з даної фігури вітрину, необхідно проробити в 

ній п'ятикутний отвір. Для цього необхідно копіювати пентагон та за 

допомогою панелі з редактором розміру зменшити фігуру відповідно до 

пропорцій які потребуються.  

 

Рис. 3.18. Заготовка вітрини 
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Щоб закінчити п'ятикутну вітрину – необхідно вкрити її склом та 

поставити на підставку. Для створення скляної панелі копіюємо 

пентагон та за допомогою панелі редактора розмірів робим його 

максимально пласким. 

 

Рис. 3.19. Модель готової вітрини 

Дотримуючись даного методу було створено решту елементів 

віртуального музею. 

Наступною дією буде створення рухомого актора та його взаємодія з 

елементами музею. Базові рухи актора, такі як: рухи вперед, назад, в 

боки та стрибки генеруються програмою автоматично. Складні анімації 

рухів та взаємодія з навколишнім середовищем програмується 

власноруч. 
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Рис.3.20. Blueprint системи руху актора 

Одним з елементів взаємодії між актором та середовищем були 

двері, що автоматично відкриваються при наближенні актора на певну 

відстань, анімація для яких створювалась власноруч. 

 

Рис. 3.21. Інтерфейс вікна для створення анімації 

 



 
Изм. Лист № Документа_ Подпись_ Дата

_ 

Лист 

26 

 

КНТЕУ 6.050103 7-17.БР 

 

 

Рис. 3.22. Blueprint для анімації дверей 

Принцип дії цієї анімації полягає в тому, що на ігровому рівні 

розміщується певна область (Trigger Box), перетнувши яку гравець 

надсилає системі сигнал про те, що вданий момент часу необхідно 

увімкнути анімацію, а коли актор перестає знаходитись в зоні, тоді 

починає діяти такий Blueprint як OnActorEndOverlap, який дає системі 

знак що необхідно запустити ту ж саму анімацію, але задом наперед. 

Наступним прикладом взаємодії є приклад взаємодії актора та 

експонатів, в даному випадку – картиною. Принцип роботи даного 

скрипта полягає в тому, що створюється окрема область при перетині 

якої на екрані з'являється віджет з вказівкою натиснути на вказану 

клавішу, щоб прослухати інформацію про вказаний експонат. Коли ця 

клавіша натискається у спеціальній створеній області – то все 

відбувається за сценарієм і звук відтворюється без помилок, але як 

тільки актор покине цю зону віджет одразу ж зникає і звук не буде 

відтворюватися. 
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Рис. 3.23. Приклад роботи взаємодії з одним експонатом 

 

Рис. 3.24. Загальна кількість зв'язків в усій програмі 
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3.3 ЕКСПОРТ ГОТОВОГО ПРОЕКТУ 

Перш ніж експортувати свій проект, вам спочатку потрібно 

встановити мапу за замовчуванням гри, яка буде завантажуватися, коли 

починається ваша гра. Якщо ви не встановили карту і використовуєте 

порожній проект, ви побачите лише чорний екран, коли починається гра. 

Щоб встановити мапу за замовчуванням гри, натисніть головне меню 

Edit> Project Settings> Maps & Modes: 

 

Рис 3.25 Вікно «Карти та Режими» 

 Щоб упакувати проект для певної платформи, у головному меню 

редактора натисніть File> Package Project> [PlatformName]: 
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Рис 3.26 Вибір платформи 

Після підтвердження цільового каталогу буде ініційовано поточний 

процес, який упаковує проект для вибраної платформи. Оскільки 

пакування може займати багато часу, цей процес виконується у фоновому 

режимі, і ви можете продовжувати використовувати редактор. Індикатор 

стану відображатиметься в нижньому правому куті редактора, щоб 

вказати прогрес: 

 

Рис 3.27 Індикатор стану 

Індикатор стану також надає кнопку Скасувати, щоб зупинити процес 

упаковки. Крім того, посилання "Показати журнал" може 

використовуватися для відображення інформації про розширений 

вихідний журнал, що є корисним для з'ясування того, що пішло не так, 

якби процес упаковки вийшов з ладу, або для виявлення попереджень, які 

могли б виявити потенційні помилки в продукті: 
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Рис 3.28 Розширений вихідний журнал 

3.4 ВИСНОВКИ ДО ТРЕТЬОГО РОЗДІЛУ 

В третьому розділі було:  

1. Описано використане програмне забезпечення , описані його 

плюси та мінуси. 

2. Описані етапи створення інтерактивного додатку 3D-музею 

КНТЕУ. 

3. Описаний процес експорту готового проекту. 
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Висновки та пропозиції 

ВИСНОВКИ ТА ПРОПОЗИЦІЇ 

У цьому дипломному проекті була проведена робота з розробки 

алгоритму та створення тривимірного музею. 

В першому розділі була описана потрібність 3D мoдeлeй в сучасній 

сфері ІТ, проаналізовані програмні засоби та побудована загальна 

концепція. 

У другому розділі були описані основні етапи розробки музею, такі як 

моделювання, конвертація, ретопологія та створення UV розгортки. 

Також було встановлено завдання та вимоги для створення музею. 

У третьому розділі був описаний повний цикл створення 

інтерактивного 3D-музею КНТЕУ, покроково описаний процес експорту 

проекту та зроблено порівняння плюсів та мінусів обраних програмних 

засобів.    

В рамках проведеного ВКП опрацьовані методи створення 3D образів 

музейних експонатів з використанням: 

● фотограмметрії 

● 3D-сканування 

● шляхом розробки та реалізації алгоритму створення тривимірної 

моделі з використанням сучасних графічних програм. 

Результати даної роботи можуть бути впроваджені при 

розробці WEB-сайту віртуального музею КНТЕУ. 

Результати цієї роботи пройшли апробацію на Міжнародних науково- 

практичних конференціях. Робота має номер державної реєстрації 

0117U000057. 
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